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Introduction

Scope and Audience of this Manual
This manual is intended for operators in charge of monitoring and managing Bull NovaScale
and Express 5800 servers with NovaScale Master, in particular via the NovaScale Master
Console. It comprises the following chapters:

 
Chapter 1 About NovaScale Master

presents NovaScale Master architecture and components.

Chapter 2 Getting Started
explains how to use NovaScale Master to perform basic monitoring
and management tasks.

Chapter 3 Using NovaScale Master Console
describes NovaScale Master Console functionalities and use.

Chapter 4 Using NovaScale Master Console Applications
describes NovaScale Master Console applications and use.

Chapter 5 Categories and Services Reference List
describes NovaScale Master monitored categories and default ser�
vices, according to operating system and hardware

Highlighting
The following highlighting conventions are used in this manual:

Bold Identifies commands, keywords, files, structures, directories, and other items
predefined by the system. Also identifies graphical resources such as
buttons, labels and icons that the user selects.

Italics Identifies chapters, sections, paragraphs and book names to which the
reader must refer for more information.

Monospace Identifies examples of specific data values, examples of text similar to what
you might see displayed, messages from the system, or information you
should actually type.

Note:
Important information

Related Publications
• For more information about NovaScale Master, please refer to:

NovaScale Master Installation Guide (Ref. 86 A2 48EG)

NovaScale Master Administrator's Guide (Ref. 86 A2 50EG)

NovaScale Master Remote Hardware Management CLI Reference Manual
(Ref. 86��A2�88EM)

NovaScale Master Server Add-ons Installation and Administrator's Guide
(Ref.�86 �A2��95ER)
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• For more information about the Bull NovaScale 3005 series, please refer to:

Bull NovaScale 3005 Series Installation and User's Guide (Ref. 86 A1 02ET)

• For more information about the Bull NovaScale 2000 series, please refer to:

Bull NovaScale Blade 2020 Installation and User's Guide (Ref. 86 A1 03EM)

Bull NovaScale Blade 2040 Installation and User's Guide (Ref. 86 A1 34EM)

• For more information about the Bull NovaScale 4000 series, please refer to:

Bull NovaScale 4020 User's Guide (Ref. 86 A2 72EG)

Bull NovaScale 4040 User's Guide (Ref. 86 A1 26EG)

• For more information about the Bull NovaScale 5000 and 6000 series and PAM software,
please refer to:

Bull NovaScale 5xx0 & 6xx0 User's Guide (Ref. 86 A1 94EM)

Bull NovaScale 5xx0 & 6xx0 Guide Utilisateur (Ref. 86 F1 94EM)

Bull NovaScale 5xx5 & 6xx5 User's Guide (Ref. 86 A1 41EM)

Bull NovaSCale 5xx5 & 6xx5 Guide Utilisateur (Ref. 86 F1 41EM)

• For information about the Intel Server Manager (ISM) management tool or Blade Chassis
Management Module (CMM), please refer to the documentation provided by Intel.

• For information about the Open Source products used by NovaScale Master, please refer
to:

www.nagios.org  (for Nagios product)

www.webmin.com  (for Webmin product)

mrtg.hdl.com  (for MRTG product)



1-1About NovaScale Master

Chapter 1. About NovaScale Master

Scope
NovaScale Master is the graphical interface tool used to manage Bull NovaScale and
Express 5800 servers. It provides two main functions:

Supervision (monitoring, reporting, information).
Supervises system resources.

Detects anomalies and notifies them to defined entities. It also provides the interface that
displays all important information.

Administration (remote control).
Used to configure target hosts and to execute actions on these hosts via the OS or via a
Hardware Management tool.

 

Remote OS
Control

Information

status

Monitoring

Remote Hardware Management

trends, �

Inventory,�

ISM
PAM

Webmin

VNC , telnet ...

Notification

– E–Mail, SNMP,
trap,Bull  Maintenance…

CMM

Alerts,
�

Reporting

S@n–IT!
+ HW

Management CLI
ARMC, ESMPRO, ...

Figure 1. Overview of NovaScale Master functions

Two NovaScale Master user roles are pre-defined:

• Operator Role: 

An operator can read host and operating system information, but has no access to the
administration tools.

• Administrator Role: 

An administrator can perform administration, configuration, update, and remote control
tasks on target hosts.
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Supervision Features
• Host Monitoring:

Checks if the target host is accessible (via the ping command).

• Monitoring Services:

Monitors OS CPU load, memory usage, disk usage, number of users, processes and
services execution, http and ftp services.

Thresholds are used to assign a state (ok, warning, critical, unknown) to hosts and to
each monitored element.

Alerts (in a log file) and notifications (by email) are generated when anomalies occur or
when normal states are recovered (return to ok state).
Monitoring Services are classified into Monitoring Categories: SystemLoad, Filesystems,
EventLog…

• Hardware Monitoring:

NovaScale servers gets hardware health status via a call to CMM, ISM and PAM
Hardware Managers.

Express 5800 servers gets power status via a call to the RMC Management Card.

• Selectable View Displays:

Presentation of hosts and monitoring services through different views. A view is a tree
structure that can display:

- the entire list of hosts,

- managers and the hosts they manage,

- host groups.

From each tree node, the user can display detailed information about a host or a service,
according to user roles (Administrator or Operator).

• Group Definitions:

Host groups and Group groups can be defined to organize server infrastructure as a tree.

• Alerts:

Notifications of problems via email, SNMP traps or Bull format autocalls.

• Selectable Map Displays:

Presentation of hostgroups (with the status of their hosts and monitoring services) through
different maps.

A map is a layout, in general with a background image, that displays associated
hostgroups. Hostgroups are located at specified positions (x,y) on the map and are
animated with the status of associated hosts and monitoring services.
From a hostgroup, the user can display detailed information about all associated hosts.

Administration Features
• Webmin Management Tool for Linux hosts.

Webmin is an OpenSource product that gives OS information (about users, filesystems…)
or executes OS commands, in a graphical environment, locally on Linux target hosts.

• Remote Operation Tools:

telnet to access Linux and Windows hosts.

UltraVNC to access Windows hosts. UltratVNC is an Open Source product that allows
you to take control of remote hosts as if you were in the remote host Windows
environment.
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• Hardware Manager Calls:

PAM for NovaScale 5000 and 6000 Series platforms.

CMM for NovaScale Blade Series Chassis 2000 platforms.

ISM for NovaScale 4000 Series hosts.

ARMC (or/and ESMPRO) for Express 5800 platforms.

For example, systems can be powered on / off via these managers and NovaScale
Master provides a single Hardware Management GUI for basic tasks.
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Basic Definitions

Service
A service is a monitoring check which supervises a monitored item. Monitoring agents
compute service status (OK, Warning, Critical, Unknown or Pending) and status information
(a text giving more information on the service state) for each service.

Example: The CPU service, which returns a status about CPU utilization, displays the
following information on Windows:

CPU Load OK (1mn: 8%) (10mn: 5%)

Category
A category is a container for a group of services.

Example: The SystemLoad category for Windows systems contains both CPU and Memory
services.

View
A view is how monitored hosts are displayed on the screen. Views differ in structure, but they
all display hosts with an animation reflecting service status (ok, warning, critical, or
unknown) and associated monitoring services, classified into categories, under the host node.

The advantage of views is to display only what the user wants to see at a given time. For
example, if a user is interested in Hosts and not in Managers or Hostgroups, he can display
the Hosts view.

As Administrator, you can create customized views for hosts and groups. Refer to the 
Administrator's Guide for details.

 Notes:

• According to configuration, a category may or may not be present. For details, refer to
the Administrator's Guide.

• Each type of node in a view has specific menus detailed later in this manual.

Map
A map can be used to display the status of a selection hostgroups (with their monitored hosts)
on the screen.

In general, the map has a background image and hostgroups are located at specified
positions (x,y) on the map. Maps differ in appearance, but they all display hostgroups with
an animation reflecting service status computed from the status of the associated hosts and
monitoring services.

When you zoom in on a hostgroup, you can view associated hosts and overall service status
(the worst status of the associated monitoring services).

The advantage of maps is to display only what the user wants to see for a given context.

As Administrator, you can create customized maps for hostgroups in different contexts. Refer
to the Administrator's Guide for details.
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NovaScale Master Components
NovaScale Master is based on a 3-tier architecture:

• Monitoring Console

This WEB-based application running in a browser (Internet Explorer or Mozilla) accesses
collected monitoring data using WEB technology.

• Monitoring Server

Collects, processes and stores monitoring and reporting data. It runs on both Windows
and Linux platforms.

• Monitoring Agent

Contains the basic programs used to obtain monitoring and inventory information. It is
installed on each target system.

NovaScale Master comprises Open Source software:

• Nagios

For the monitoring function.

• MRTG

For the reporting indicators function.

• Webmin

A Linux administration tool (a standard Webmin package and a NovaScale Master
Webmin restricted to obtaining information).

• UltraVNC Server

For remote operation on Windows hosts.

• IPMItool 

For remote operation on hardware systems.

NovaScale Master also comprises an optional component for scripting applications on Linux
platforms:

• Hardware Commands

A Command Line Interface (CLI) for remote hardware management, providing an easy
interface for automating scripts to power on/off or get the power status of a system.
These commands can only be used on Express 5800, or NovaScale 4000, 5000 and
6000 series servers with a Linux Operating System.
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NovaScale Master and Security
NovaScale Master security is based on a combination of secured applications using
authentification and profiling (role based) mechanisms.

Authentication
Each NovaScale Master application uses a user/password or single password authentication
mechanism for access. Users are defined on the NovaScale Master server.

Role-based Management
Each NovaScale Master Console user is associated to a role (or set of functionalities). There
are two types of profiled users:

• Operator

An operator can read host and operating system information, but has no access to the
administration tools.

• Administrator

An administrator can perform administration, configuration, update, and remote control
tasks on target hosts.
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Chapter 2. Getting Started

This chapter explains how to use NovaScale Master for basic monitoring and administration
tasks.

Starting the Console
See Chapter 6 of the Installation Guide for details on how to launch the console and
applications.

Console Basics

 

Figure 2. NovaScale Master console

The NovaScale Master console is divided into the following functional parts:

Title Bar displays the server name.

Administration Tools enables access to the administration tools: NovaScale Master
configuration application, NovaScale Master documentation and
NovaScale Master download page. Displays server information:
Netname, Date/Time, Login and Role.

Supervision Mode allows you to choose one of the three modes of supervision:
supervision through a tree, supervision through a map and
supervision through alerts.

Supervision Pane displays information about the monitored resources, related to the
type of supervision (see Supervision Information, on page 3-20).
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NovaScale Master Tools enables access to the NovaScale Master Tools: Reports and
Hardware Management.

Other Tools enables access to external applications.

NovaScale Master Authentication and Roles
NovaScale Master applications must be authenticated. They use common NovaScale Master
users defined on the server part.

Authentication type varies according to the NovaScale Master Server operating system (Linux
or Windows) and to the WEB Server (Apache or Microsoft IIS) (see next paragraphs).

Note:
In order to change the current authentication for NovaScale Master. You MUST close all the
opened WEB browser windows. And relaunch a new session of this browser. Else, the
browser will keep the previous authentication context.

Role Based Management
Moreover, the authenticated user is used to apply a user profile or role.

Two default roles have been defined for NovaScale Master:

Operator with access only to supervision information.

Administrator with access to supervision information, configuration tasks and Remote
Control functions.

Applications Roles Functions

Monitoring and Reporting Operator Information access

Administrator + server control access

Remote Control OS Operator None

Administrator Remote Control access

Hardware & Storage managers Operator Information access

Administrator + Remote Control access

Table 1. Roles and Functions

Note:
User roles can be only configured by a user with Administrator role. For further details, refer
to the Administrator's Guide.
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NovaScale Master Server User Authentication - Linux

Apache server authentication
A default Apache user called nsmadm (password nsmadm) is created when NovaScale
Master Server is installed. This user is not a Linux user and will only be used contextually by
this WEB Server.

 

Figure 3. nsmadm user authentication - Linux

The users database is stored in the following file:
/usr/local/bull/SystemManagement/core/etc/htpasswd.users

Adding a New User / Modifying a Password
To add a new user or to modify a password on the Apache server:

1. Log on as root and launch the following command followed by the required user name:

# htpasswd /usr/local/bull/SystemManagement/core/etc/htpasswd.users  <USERNAME>

2. Enter the new password: *****

3. Re-type the new password: *****

Adding password for user <USERNAME>

where <USERNAME> is the user name you want to add or modify.
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NovaScale Master User Authentication - Windows
Authenticated users are users declared in the Windows users database.

Using Internet Services Information WEB Server
The user can be a local user or a domain user. The domain must be specified for domain
users (e.g DOMAIN\User).

 

Figure 4. User authentication with IIS WEB Server - Windows

Using Apache WEB Server
Any user in the Windows user database of the server, or any trusted domain to which the
server belongs, will be granted access.

The user name must be entered in the following format: DOMAINNAME\Username, even for
local users. The domain name must be fully qualified.

 

Figure 5. User authentication with Apache WEB Server - Windows

This chapter continues with the description of what you can do with the console.
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Displaying Monitoring Information

Starting with the Tree mode

 Notes:

• Tree Mode concepts are explained in detail in Chapter 2.

• When the Console is started, the default view is opened, i.e. the Hosts view, displaying all
the declared hosts at the same level.
By clicking in the File menu, you can load three other views: the Hostgroups view, the
HardwareManager view or the StorageManager view.
As Administrator, you can change the default view and advanced users can create
customized views. Refer to the Administrator's Guide for details.

The left part of the console is a tree representing all the managed platforms. It can be
expanded as shown below:

Level 0: Root

Level 1: Host

Level 2: Category

Level 3: Monitored Service

Figure 6. Example of expanded Hosts tree

A Service is a Monitored Entity and the color of the icon reflects service status: red (critical),
orange (warning), magenta (unknown) or green (ok).

Each icon is divided into two sections:
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The top left is reserved for the animation for itself and the bottom right is reserved to cascade
animation from its subtrees.

For instance for a Host node: When there is a service status change, the color of the bottom
right corner of the category icon changes to reflect this change.

The color of the top left corner of a host icon indicates if this host is alive or not (result of a
ping command).

Example:

The top left corner of the nsmaster host node is green because it is alive and the bottom right
corner is green because all its services are ok.

A Category is a node grouping monitored services logically. Category status reflects the
worst status of its associated services..

Looking in the Past
When a problem occurs, it is interesting to know if it already occurred in the past, and how
many times it occurred.

NovaScale Master offers many ways to analyze what occurred in the past.

Looking in the Past with Alert History
From the Applications pane, click Reporting -> Alert History. The following display appears
(in this example, the host is called FRCLS5208).

Figure 7. Alert History window

The history shows all the alerts that occurred for this service, in periods of time. Service
information is also logged, providing all the information required to decide if a corrective
action is needed.

Looking in the Past with Status Trends Information
The Alerts and Trends functions use monitoring logs to display past information:

• Alerts shows events.

• Trends shows a status graph for a given period of time.
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In the example shown in Figure 8. the monitored system is FRCLS5208. The tree shows a
CRITICAL state on EventLog.Security. Click Security to display status information.

Figure 8. Status Information for EventLog.Security service

If you want to know if this situation often occurs, and when it occurs, click Reporting →
Status Trends. The following display appears:

Figure 9. Status Trends for EventLog.Security service (last 24 hours) - example

The graph shows the situation for the last 24 hours and that nsmaster has detected a recent
bad security access.
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Viewing More Information
The Applications pane is used to display information requested by menu items or links.

Click a node in the Tree pane to display basic monitoring information, according to node
type.

Right-click a node in the Tree pane to display a popup menu giving access to all operations
available for that node.

Click an option in the double level menu in the Applications pane to access to all information
available for that node.

Example:

When you click the nsmaster node, the following display appears, indicating that the status
for this host is UP:

Figure 10. Host status display - example
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From the Applications pane, click Hardware Information -> Inventory to display the host
hardware inventory.

Figure 11. Host information - example
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Receiving Alerts
As Administrator, once you have built your configuration, you can set up email and/or snmp
notifications for enhanced operational monitoring

Sending Email Notifications
To configure the email notification mechanism, proceed as follows:

Step 1: Start NovaScale Master Configuration.

Step 2: Configure the Mail Server (only if NovaScale Master Server runs on a Windows
system).

Step 3: Specify the mail address of the receiver.

Step 4: Reload the monitoring server to take the modifications into account.

Refer to the Administrator's Guide for details.

Sending SNMP Traps Notifications
To configure the SNMP notification mechanism, proceed as follows:

Step 1: Start NovaScale Master Configuration.

Step 2: Specify the SNMP managers to which the traps will be sent.

Step 3: Reload the monitoring server to take the modifications into account.

Refer to the Administrator's Guide for details.

Viewing Notifications

In the following example, an authentication failure has generated an email notification:

***** Bull NovaScale Master *****

Notification Type: PROBLEM

Service: LogicalDisks.All

Host: w2k–addc01 Description: Portal DC (current network name: w2k–addc01)

Address: w2k–addc01

State: CRITICAL

Date/Time: Wed May 18 16:26:21 GMTDT 2005

Additional Info:

DISKS CRITICAL: (Z:) more than 95% utilized.

The NovaScale Master Console allows you to view all the notifications sent by the monitoring
server.
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Taking Remote Control of a Host
As Administrator, if you want to investigate a problem and fix it, you need to take a remote
control of the platform concerned. NovaScale Master uses standard, commonly used tools to
perform this function. These tools differ according to whether the remote operating system is
Windows or Linux.

Windows Hosts
UltraVNC Viewer is used to to remotely connect to Windows hosts.

Note:
Prerequisite: The VNC package delivered with NovaScale Master must be installed and
started on the remote host. Refer to the Installation Guide for details.

Example:
NovaScale Master informs you that the C: disk is nearly full on the nsmaster Windows host,
via the LogicalDisks node, and you decide to connect to nsmaster to see if you can free some
disk space.

To connect to the remote host:

1. Start VNC Viewer from the nsmaster host menu (Operations -> Operating System
->�VNC�Viewer) .

Figure 12. Starting UltraVNC Viewer on a host
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2. When prompted, enter the password used when VNC Server was installed or configured
on the target host (nsmaster in the example).

Figure 13. VNC Authentication window

3. Click OK. You now have full access to the remote host (nsmaster), although response times
may be longer.

Figure 14. Remote connection to a Windows host with VNC Viewer

You can now display information related to disk C: and perform corrective actions.
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Note:
If you do not require full access to the remote desktop, you can also open a telnet
connection, if the  telnet service is started on the remote host.

Linux Hosts
Webmin is used to remotely connect to Linux hosts.

Note:
Webmin is a graphical tool for managing Linux systems and allows you to configure the
system, application servers (http, mail…), the network, and many other parameters. Webmin
is Open Source software and the Open Source Community regularly adds new modules.

Example:
You want to add a new user to your FRCLS2681 Linux host.

1. From the FRCLS2681 host menu, select Operations -> Operating System -> UsersActions
-> Users.

Figure 15. Launching Webmin window

A Webmin page opens and prompts you for a user / password. As Administrator, you can
connect as root, with the corresponding Linux password.
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Figure 16. Webmin login window

Note:
If the Linux host is running in SSL mode the following message appears, before the Webmin
login page: 
This web server is running in SSL mode. Try the URL https://<hostname>:10000/

instead.

You must click the link indicated in this message.

You are now in the Webmin page that manages Users and Groups:

Figure 17. Webmin interface on Linux hosts

2. Add a new user by clicking Create a new user.
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Managing Hardware

Using the System Native Hardware Manager
Hardware monitoring and management - such as temperature or voltage monitoring, remote
power control, access to BIOS or system logs - is not directly performed from NovaScale
Master.

Each type of server has a dedicated hardware manager that NovaScale Master uses to
perform these operations. NovaScale Master provides the appropriate menu item for each
server type: , that is:

• PAM for NovaScale 5000 and 6000 series

• ISM for NovaScale 4000 series

• CMM for NovaScale Blade series

• ESMPRO for Intel based computers, running Windows

• RMC or ARMC for Intel based computers

• Any other manager that can be accessed via a URL.

 Notes:

• The corresponding Hardware Manager MUST be installed and configured. Please refer to
the documentation delivered with the server for details.

• When the Hardware Manager is launched via a URL (Web GUI), the browser on the
console must be configured to access this URL without using an HTTP proxy.

• Connection to PAM, ISM, RMC and CMM hardware managers requires authentication.
Logins must be defined in the management modules before they can be used by
NovaScale Master.
CMM: only one session is allowed per user. You must therefore register one user for each
NovaScale Master Console (used when the Manager GUI is launched from the
Management Tree).

• NovaScale Blade hardware monitoring is performed through the CMM SNMP interface.
You must therefore declare the NovaScale Master server as SNMP Manager when you
configure the CMM.

To manage hardware, proceed as follows:

Step 1: Declare a HW manager and the hosts or platforms it manages.

Step 2: Reload the monitoring server to take the modifications into account.

Step 3: Call the HW Manager from the Tree pane.

Example:
Calling a configured PAM Manager:

The Operations -> Platform -> PAM item appears in the menu of the nsmaster host.
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Figure 18. HW Manager GUI menu

Activating the Hardware -> PAM menu item calls the associated PAM HardWare Manager:

Figure 19. PAM Hardware Manager - Home Page

See the Administrator`s Guide for details.
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Using the NovaScale Master Hardware Management Application
NovaScale Master also provides its own Hardware Management application that can be
used instead of the native hardware managers (e.g.  PAM, CMM, …). The NovaScale
Master Hardware Management application gives the same look and feel for all hardware
operations, independently of the target server type.

The application manages Power Control, and displays FRUs, Sensors and System Event Logs
for Express 5800 and NovaScale 4000, 5000 and 6000 series servers.

To start the application:

From the Console Management Tree, click the Operations -> Platform -> Power Control item
in the host menu.

Figure 20. Launching Remote Hardware Management window
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Action Pane

Display Pane

Host selection Pane

Figure 21. Remote Hardware Management window

The NovaScale Master Remote Hardware Management application window is divided into
the following functional parts:

Host Selection Pane allows you to select the current host from all declared Express 5800
and NovaScale 4000, 5000 or 6000 series servers.

Action Pane displays the hardware operations that can be performed:

-  Power control functions

-  FRU visualization

-  Sensor visualization

-  Event log visualization

Display Pane  displays parameters forms, messages and command results.
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Following a Performance Indicator over a Large Period
It may be interesting to follow the evolution of certain performance indicators over a large
period (e.g. the evolution of the memory use).

Performance indicators can be collected from NovaScale Master monitoring data or SNMP
protocol, as described below.

To collect and visualize performance indicator reports, proceed as follows:

1. Launch NovaScale Master Console from the NovaScale Master Home Page.

2. Click the Reports icon to display the list of all available reports.

3. Select the report you want to display from the indicators list.

Figure 22. NovaScale Master Reporting Indicators Home Page
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The following display appears:

 

Figure 23. NovaScale Master Reporting Indicators - example

This display shows 4 graphs (3 visible in the example). Each graph shows the evolution of an
indicator (here CPU load) for different periods (daily, weekly, monthly and yearly).
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NovaScale Master Configuration
Please refer to the Administrator's Guide for details about configuration tasks.
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Chapter 3. Using NovaScale Master Console Supervision
Modes

The NovaScale Master console provides three supervision modes, each providing its own
representation of the NovaScale Master monitored resource:

• Tree mode

• Map mode

• Alerts mode

Whatever the mode, the characteristics of a selected monitored resource are automatically
displayed in the Supervision Pane.

Note:
For further information about Console Basics and Console Security Access, refer to Console
Basics and NovaScale Master Authentication and Roles.

Working in the Tree Mode
When you select the Tree radio button, a Management Tree is displayed in the Supervision
Pane.

Management Tree Basics
The Management Tree is a hierarchical representation of the resources defined in the
NovaScale Master configuration. Each resource displayed in the tree is represented by a
node that may or may not have subnodes.

Figure 24. Management Tree

Double-click a node or click the +/- expand/collapse icon to display subnodes.

Select a node to automatically display its characteristics in the Supervision Pane.

Right-click the mouse to display the specific node menu.
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Figure 25. A service node menu

Upper the Management Tree, a menu provides the File, Views and Tools commands:

 

Figure 26. Management Tree menu

 Management Tree Menu

File ->Load

->Reload

-> Close

->Hide Tree

Selects a view to be loaded.

Reloads the current view if the configuration has been modi�
fied.

Closes the current view.

Hides the tree to display the whole Supervision Pane

Views Displays the list of all loaded views: you can select one view.

Tools -> Find Allows you to search a node in
the current view according to
its name or part of its name.

-> Refresh Delay This dialog box allows you to
modify the Management Tree
animation refresh delay.

The default refresh delay is
120 seconds.

Figure 27. Management Tree commands

Note:
The refresh delay is only used by the Management Tree, not by applicative panes.
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Management Tree Animation
The Management Tree is animated according to the following rules: 

• Color is dependent on status:

Red CRITICAL
Orange WARNING
Magenta UNKNOWN
Green OK
Blank UNMONITORED

This color scheme is applicable to hosts and services.

• When a node has subnodes, the node icon is split in two. The top left triangle is animated
to represent node status and the bottom right triangle to represent subnode status (i.e. most
degraded status).

• Host and associated monitoring services node icons are animated to represent self-status.
All other node icons are animated to represent subnode status (i.e. most degraded status).

Example:

SYSMAN (root node) and associated services are self-monitored. The top left triangle is
GREEN, showing that host status is OK (the ping operation is successful), but the bottom right
triangle is RED, showing that at least one service status is CRITICAL.

 

Figure 28. ManagementTree animation - example

Right-click the animated nodes to display the Diagnosis and On/Off menus:

 

Figure 29. Animated node menu

Diagnosis displays an animation information window.

 On activates node animation.

 Off deactivates node animation. This option is useful if you decide not to ani-
mate a specific service or host.
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Example:

Animation of the System and All services nodes has been deactivated. As these nodes are no
longer monitored, status is not propagated (icons are BLANK) and SYSMAN (root node)
status is now OK.

Figure 30. Deactivating supervision - example

Note:
Monitoring services are independent due to the server polling mechanism. This may create a
temporary de-synchronization during an animation refresh.
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Management Tree Nodes
Each NovaScale Master monitored resource is represented as a node with a specific icon in
the animated Management Tree. Management Tree nodes are animated according to node
status. When a node is selected, its characteristics are automatically displayed in the
Supervision Pane.

Monitored Resourcest  Icons Description

Root Node First node in the tree.

HostGroup Hosts can be grouped into hostgroups. For example, an
administrator can define a hostgroup containing all NT
servers. Doing so allows you to quickly identify a host in
a degraded state, as host status is propagated up to the
hostgroup node.

Group Groups allow you to gather other groups and host�
groups in coherent entities. Refer to the Administrator’s
Guide  for details.

Platform A platform is a physical group of hosts of the same
type.

Hardware Manager Several hardware managers can be displayed:
• PAM Manager for NovaScale 5000 and 6000

Series Platforms.
• CMM Manager for NovaScale Blade Series Chassis.
• ISM Manager for NovaScale 4000 series Platforms.
• ESMPRO Manager for Express 5800 hosts.
• RMC manager for Express 5800 hosts.
• Any other hardware manager.

Storage Manager Two storage managers can be displayed:
• S@N.IT! Manager for shared host storage via a

SAN.
• Any other storage manager.

Host ia64

ia32

other

A host is composed of categories.

Category A category contains specific monitoring services. For
example, the SystemLoad category contains the CPU
service and the Memory service.

Service Each service belongs to a category.

Table 2. Management Tree nodes

Note:
Currently, NovaScale 64 bits is applicable to NovaScale 4xxx, 5xxx and 6xxx servers and
NovaScale 32 bits is applicable to NovaScale 2xxx and Express 5800 servers.
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Root Node
The Root node is the first node in the tree. The top left triangle reflecting self-status is always
blank (unmonitored). The bottom right triangle reflects the most degraded subnode status
(host and services).

Root node menu

Expand Shows a tree view of all hosts, hostgroups or managers in the
configuration.

Animation Briefly explains resource status.

Table 3. Root node menu

Hardware Manager Node and Status Levels
A HardwareManager node represents one of the five types of hardware managers listed in
Table Management Tree Nodes above.

PAM and CMM Managers Status Levels
The top left triangle reflects self-status and the bottom right triangle reflects the most degraded
subnode status (hosts and services), as shown in the following table:

Manager (PAM, CMM) Status Levels

Status Description

PENDING
(gray)

The service has not been checked yet. Pending status occurs
only when nagios is started and disappears as soon as services are
checked.

OK
(green)

The manager is up and running.

WARNING
(orange)

The manager has a problem, but is still partially up and run�
ning.

UNKNOWN
(magenta)

An internal plugin error has prevented status checking. An un�
known status is considered as a warning status.

CRITICAL
(red)

The manager has a serious problem or is completely unavail�
able.

Table 4. PAM and CMM status levels

RMC Managers Status Levels
The top left triangle reflects  power status and the bottom right triangle reflects the most
degraded subnode status (hosts and services), as shown in the following table:

Manager (RMC) Status Levels

Status Description

PENDING
(gray)

The service has not been checked yet. Pending status occurs
only when nagios is started and disappears as soon as services are
checked.

OK
(green)

The power status is on.

UNKNOWN
(magenta)

An internal plugin error has prevented status checking. An un�
known status is considered as a warning status.

CRITICAL
(red)

The power status is off.

Table 5. RMC status levels
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ISM and ESMPRO Managers Status Levels
The top left triangle reflecting self-status is always blank (unmonitored). The bottom right
triangle reflects the most degraded subnode status (hosts and services). 

Hardware Manager Node Menu

Expand -> PAM manager 

 -> CMM manager

-> RMC, ISM or ESMPRO

 -> other managers

Shows all NovaScale 5000 and 6000 Series
platforms managed by this PAM manager.

Shows all NovaScale Blade Series Chassis managed
by this CMM manager.

Shows all hosts managed by these managers.

Shows all hosts managed by these managers.

Animation Briefly explains resource status.

Table 6. Hardware Manager node menu

StorageManager Node
The StorageManager node represents either the S@N.IT! Manager or any other storage
manager.

The top left triangle reflecting self-status is always blank (unmonitored). The bottom right
triangle reflects the most degraded subnode status (hosts).

Storage Manager node menu

 Expand Shows all hosts managed by this manager.

Animation Briefly explains resource status.

Table 7. Storage Manager node menu

Note:
The S@NIT Web GUI is based on an java applet technology. So, don't close the first
launched browser windows which doesn't contain the GUI but the applet itself.

Platform Node and Hostgroup Node
A Hostgroup node represents a group of hosts. A platform node is a specific hostgroup
node, which represents a group of hosts of the same type.

The top left triangle reflecting self-status is always blank (unmonitored). The bottom right
triangle reflects the most degraded subnode status (hosts and services).

Hostgroup Node MenusPlatform Node and

Expand Shows the hosts contained in this hostgroup or this plat�
form.

Animation Briefly explains resource status.

Table 8. Platform node and Hostgroup node menus
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Host Node and Status Levels
A Host node represents a single host. The top left triangle reflects self-status and the bottom
right triangle reflects the most degraded subnode status (services).

Host Status Levels

Status Description

PENDING
(gray)

Host status is unknown because no associated service has been
checked yet. Pending status occurs only when NetSaint is started, and
disappears as soon as at least one associated service is checked.

UP (green) The host is up and running.

DOWN (red) The host is down or unreachable.

Table 9. Host status levels

Host Node Menu

Expand Shows all monitoring categories associated with
this host.

Animation  -> Diagnosis

->On / Off

Briefly explains resource status.

Activates / deactivates node animation.

Table 10. Host node menu

Category Node
A Category node contains specific monitoring services. 

The top left triangle reflecting self-status is always blank (unmonitored). The bottom right
triangle reflects the most degraded subnode status (services).

Category Node Menu

 Expand Shows all monitoring services belonging to this category.

Animation  Briefly explains resource status.

Table 11. Category node menu

Services Node and Status Levels
A Services node is a leaf node.

The service node reflects the service status computed by the monitoring process, as shown in
the following table: 

Service Status Levels

Status Description

PENDING
(gray)

The service has not been checked yet. Pending status occurs only
after NetSaint is started and disappears as soon as services are
checked.

OK (green) The monitored service is up and running.

WARNING
(orange)

The monitored service has a problem, but it is still partially up
and running.

UNKNOWN
(magenta)

An unreachable or internal plugin error has prevented service
status checking. An unknown status is considered as a warning
status.

CRITICAL (red) The service has a serious problem or is completely unavailable.

Table 12. Service status levels
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Service Node Menu

Animation -> Diagnosis 

 -> On / Off

Briefly explains resource status.

Activates / deactivates node animation.

Table 13. Service node menu

Management Tree Views
Management Tree views allow you to represent monitored resources according to your needs
at a given time. The Management Tree provides four standard views:

• Hosts

• HostGroups

• HardwareManagers

• StorageManagers

The default view is the Hosts view, but you can load another view by selecting:

File -> Load -> SystemMgt -> view name

Once several views have been loaded, you can switch from a one view to another by
selecting:

Views -> view name

Standard Tree Views

Hosts View All hosts are displayed under the root node.

HostGroups View All hostgroups in the configuration plus all NovaScale
5000 and 6000 Series platforms and NovaScale Blade
Chassis are displayed as hostgroup nodes with their asso�
ciated hosts.

HardwareManagers View All hardware managers in the configuration are displayed.
Each manager node contains the hosts that it manages.
For example, the PAM manager nodes contain the NovaS�
cale 5000 and 6000 Series platforms and the CMM man�
ager nodes contain the NovaScale Blade Chassis.

StorageManagers View All storage managers in the configuration are displayed.
Each manager node contains the hosts that it manages.

Table 14. Tree views

Note:
As Administrator, you can create customized views to meet your own criteria. Please refer to
the Administrator's Guide for details.

Hosts View
The Hosts view is the default view. All the hosts in the configuration are displayed with their
monitoring services classified by category (EventLog, LogicalDisk …), as shown in the
following figure.
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Figure 31. Hosts view

HostGroups View
The HostGroups view displays all the hostgroups in the configuration.

Hosts are displayed under each hostgroup, with their monitoring services classified by
category (EventLog, LogicalDisk ...), as shown in the following figure.

 

Figure 32. HostGroups view

In the example shown above, the administrator has defined a Windows hostgroup grouping
all Windows servers. The bottom right triangle of a hostgroup icon is not green, meaning
that a host or a service has a problem. The operator can expand the hostgroup icon to
identify the host or service with a problem.

HardwareManagers View
The HardwareManagers view displays all the managers in the configuration:

• PAM Managers, displaying NovaScale 5000 and 6000 Series platforms with their hosts
(domains)

• CMM Managers displaying NovaScale Blade Chassis with their hosts (NS 20x0)

• RMC, ISM or ESMPRO Managers displaying other hosts.
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• Hosts are displayed with monitoring services classified by supported category (Hardware,
EventLog, LogicalDisk...), as shown in the following figure:

 

Figure 33. HardwareManagers view
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StorageManagers View
The StorageManagers view displays all the storage managers in the configuration.

Hosts are displayed with monitoring services classified by supported category (Storage,
EventLog, LogicalDisk ...), as shown in the following figure:

 

Figure 34. StorageManagers view



3-13Using NovaScale Master Console Supervision Modes

Working in the Map Mode
When you select the Map radio button, the Map, Focus and Problem Panes are displayed.

Note:
The Map and Problem panes are always synchronized.

• The Problem pane lists the problems that occurred on hosts belonging to hostgroups on the
current map. Each hostgroup is represented by an animated rectangle (rectangle
dimensions are specified in the Configuration GUI). The Select a map box allows you to
select another configured map.

• The Focus Pane lists all the services (with their status) configured to be displayed in this
pane. As Administrator, these monitoring services are highly important and need to be
displayed in a specific pane. This pane appears only when there exists configured focus
services. (See Administrator's Guide for more information).

Figure 35. Map mode

In the Map Pane, hostgroups are displayed and animated with their computed status. Their
positions (x,y) are specified in the Configuration GUI.

Hostgroup status is the most degraded status of corresponding hosts and monitoring services.

The Problem Pane lists all the problems that occurred on any host belonging to the hostgroups
on the map. You can navigate thru internet links and return using the Back button.

Note:
For each Map, a corresponding internal hostgroup (with name "<MapName>_map" is
generated for the monitoring server (used by the Problem Pane).

If you want to zoom a specific hostgroup, select it on the map. When the mouse is hovered
over a square representing a hostgroup, an Infotip displays the hostgroup name and position
(x,y):



3-14 User's Guide

Figure 36. Hostgroup details

When a hostgroup is selected, the status of all the hosts belonging to that hostgroup are
displayed, along with three links to more information:

• Hostgroup name link (perso in Figure):

This link opens a new window giving grid status information about all current hostgroup
host services.

Figure 37. Hostgroup link information
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• Host name link (frcls2101.frcl.bull.fr in Figure):

This link opens a new window giving monitoring information about all current host
services.

Figure 38. Host services

• Alerts link:

This link opens a new window giving alert information about all current hostgroup host
alerts.

Figure 39. Hostgroup alerts
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Working in the Alerts Mode

Alert Basics
The Nova Scale Master Alert Viewer application displays monitoring alerts (also called
events) concerning a set of hostgroups, hosts and services.

The application provides filter functions in order to display alerts on all monitored resources
or on only a subset of these resources.

Whenever a service or host status change takes place, the monitoring server generates an
alert, even when status passes from CRITICAL to RECOVERY and then to OK. Alerts are stored
in the current monitoring log and are then archived.

The NovaScale Master Alert Viewer application scans the current monitoring log and
archives according to filter report period settings.

Figure 40. Nova Scale Master Alert Viewer

Nova Scale  Master Alert Viewer is divided into two main functional parts:

• The Selection Pane, where all filters are taken into account like a logical AND. Exception:
when the Alert level is set to display Current problems only, the Time Period is
automatically set to This Year, and cannot be modified.

• The Information Pane, which displays filtered alerts.
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Alert Selection

Note:
By default, alerts for all hostgroups, all hosts and all services are displayed.

Figure 41. Alert Selection

Selecting Hostgroups, Hosts and Services
You can filter hostgroup, host and service Alerts from the Selection Pane, in any combination:

• When you select a specific hostgroup, only the hosts belonging to that hostgroup are
selected.

• When you select **ALL HOSTS**, all the hosts belonging to the previously selected
hostgroup are selected.

• When you select a specific host, only the services belonging to that host are selected.

• When you select **ALL SERVICES**, all the services belonging to the previously selected
host are selected.

• When you select  **ALL HOSTS** and **ALL SERVICES**, all the hosts belonging to the
previously selected hostgroup (or all hostgroups) are selected and all the services
belonging to those hosts are selected.

Example:

Figure 42. Alert selection - example

In this example the user has decided to select all alerts concerning SystemLoad.CPU on the
nsmaster host in the NS_Master hostgroup.

Selecting Alert Type
You can filter alerts according to the following alert types:

- Hosts and Services

- Hosts

- Services

Note:
By default, Hosts and Services is selected.
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Selecting Alert Level
You can filter alerts according to the following alert levels:

• All alerts

displays all alerts.

• Major and Minor problems

displays host alerts with DOWN or UNREACHABLE status levels.

displays service alerts with WARNING, UNKNOWN or CRITICAL status levels.

• Major problems

displays host alerts with DOWN or UNREACHABLE status levels.

displays service alerst with UNKNOWN or CRITICAL status levels.

• Current problems

display alerts with a current non-OK status level.

When this alert level is selected, the Time Period is automatically set to `This Year' and
cannot be modified.

Note:
By default, All is selected.

Selecting Acknowledged Alerts
As Administrator, you can acknowledge alerts and decide whether they should be displayed
or not.

Acknowledge icon

Figure 43. Acknowledged alerts selection

Note:
By default, All alerts is selected (acknowledged or not).

Selecting Alert Histories
By default, all the alerts concerning a particular service of a particular host with a given
status level are displayed in a single line:

• The Count field lists the number of similar alerts over the specified Report Period.

• The Time field displays the time when the most recent alert was generated.

• The Information field details the most recent alert.

When you select this option, each alert is displayed in a different line:

• The Time field displays the time when the alert occurred.

Selecting Time Periods
The user can specify the period of time over which alerts are displayed:

• Last 24 Hours

• Today

• Yesterday

• This Week
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• Last 7 Days

• Last Week

• This Month

• Last Month

• This Year

• Last Year

• *CUSTOM PERIOD*

When you select *CUSTOM PERIOD*, you can specify time period start and end dates. The
default *CUSTOM PERIOD* setting is the beginning of the current month through to the current
date.

Note:
By default, alerts over the Last 7 Days are displayed.

Selecting Max Items

This option allows you to specify the maximum number of lines displayed.

Note:
By default, the Max Items setting is 15.

Alert Information
Alerts give the following information:

• Time: i.e. when the alert occured

• Host Name: i.e. where the alert occured

• Service Name: i.e. where the alert occured

• Status Level

• Count

• Information

Note:
The Count field is always set to 1 if the History option is set to true. Otherwise, the Count
field indicates the number of alerts with the same status level. Time and Information fields
concern the most recent alert.
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Supervision Information

Supervision Information Basics
The Supervision Pane displays information about monitored resources and works exactly like
a WEB browser. You can click a link, retrace your steps (back, forward), reload a page,
detach a page and print a page. The Supervision Pane is divided into five functional parts,
as shown in the following figure:

Figure 44. Supervision Pane

Tool Bar  Go back one page

  Go forward one page

  Reload the current page

  Modify the information pane refresh delay

  Reload the first page page

  Detach the current page to a separate frame

Title Pane Displays the selected monitored resource icon, type and name.
  Only available for hosts. Gives a short description of the selected

host (name, model, OS, netname and domain).

Menu Level1 Allows you to select the type of functional domain you want to access,
according to the selected resource: Monitoring, Reporting, Inventory,
Operations.

Menu Level2 Allows you to select the information or operation you want to access,
according to selected Level1 information.

Menu Level3 Allows you to select the information or operation you want to access,
according to selected Level2 information.

Information Pane Displays selected information about the selected resource.
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Monitoring Information
The following table lists the available information types and associated supervision scope.

Information Type Supervision Scope
Status Overview Root nodes of Hosts and Hostgroups Views (Tree)

Hostgroup
Status GRID Root nodes of Hosts and Hostgroups Views (Tree)

Hostgroup
Status Detail Root nodes of Hosts and Hostgroups Views (Man�

agement Tree)
Hostgroup

Host Status Host
Service Status Service
Network Outages Not yet supported
Config Root nodes of Hosts and Hostgroups Views (Tree)
Log Root nodes of Hosts and Hostgroups Views (Tree)
Control Root nodes of Hosts and Hostgroups Views (Tree)

Table 15. Monitoring information

Status Overview
This screen allows you to view the current status of all monitored hosts and services.

• When you launch this screen from the hostgroup node, a status overview of all hostgroups
(or a particular hostgroup) is displayed.

Figure 45. Hostgroup Status Overview

Host Group Hostgroup name

Host Status Totals Number of hosts classified by status level in the hostgroup

Service Status Totals Number of services classified by status level in the hostgroup

• When you launch this screen from the host node, a status overview of all hosts is
displayed.

Figure 46. Host Status Overview

Host Host name

Host Status Host status level

Service Status Number  of services classified by status level
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Status GRID
This screen displays the name of all the monitored services for each host.

Figure 47. Host Status GRID

Host Host name

Service Status Host services animated by status level color

Status Detail
This screen gives detailed information about selected hosts and/or services.

Figure 48. Hosts Status Detail

The Selection Pane allows you to select host and service according to status level:

Host Selection Number of hosts with Up, Down, Unreachable or Pending status.
You can select hosts according to status: All hosts, Problem hosts, or
Specific hosts.

Selected Host Services Number of services with OK, Warning,Unknown,Critical or Pending
status. You can select services according to status: All services,
Problem services, or Specific services.

Information details gives host details if host is selected and service details if host and service
are selected.

See Host Status and Service Status for more information.

Host Status
This screen gives a detailed view of the status of the selected host.
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Figure 49. Host Status

Host Host name

Host Status Host status

Last Check Time since the last check occurred

Duration Time since the current state was set

Information Additionnal information about the host state

Service Status
This screen gives a detailed view of the status of all the services associated with the selected
host. Services can also be selected according to status level.

Figure 50. Services Status

The Selection Pane allows you to select services according to status level:

Selected Host Services Number of services with OK, Warning, Unknown, Critical, or
Pending status. You can select services according to status: All
services, Problem services, or Specific services.

Information Details gives status details for the selected services:

Service Service name
Status Service status
Last Check Time since the last check occurred
Duration Time since the current state was set
Information Additional information about service status
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Config
This screen displays the  Monitoring Server (nagios) configuration objects (hosts, hostgroups,
services, contacts, contactgroups, timeperiods and commands) that you have defined .

Figure 51. Monitoring Server Config
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Log
This screen displays the current Monitoring Server log file. You can also browse archived
events.

Figure 52. Monitoring Server Log

NovaScale Master Log shows all the events logged by the monitoring process:

The screen is divided into two parts:

• The top part of the screen allows you to modify the display according to a set of criteria:

Event Log selection By default, only the entries recorded in the current
log are displayed. To see older entries, you can se�
lect an archived log.

Earliest Entries First Allows you to select the order of entries displayed.
By default, the most recent entries are displayed first.

• The bottom part of the screen displays logged events:

- Host and Service alerts

- Alert notifications

- Alert acknowledgements

- New comments

- Configuration information messages

- Miscellaneous
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Control
When you launch the Control screen from the Hosts or Hostgroups root nodes, Monitoring
Server information is displayed. You also have links to get Detailed Information and a
lanching point for sending commands to the monitoring server.

Figure 53. Monitoring Server commands

Monitoring Server Information
Gives general information about the Nagios monitoring process.

Commands
Allows you to perform actions on monitoring functions.

When you click a command, you are prompted to confirm by clicking Commit in the
confirmation page. The command is posted for immediate execution by the Monitoring
Server.

Note:
Process Commands require Administrator rights.

Detailed information
Allows you to access detailed information about the performance and scheduling queue

Performance Information gives statistical information about the Nagios monitoring process
for each kind of check:

- the minimum, maximum and average time recorded for check execution

- the minimum, maximum and average time recorded for check latency (check delay
time due to monitoring server overload)

- the current number of active service checks

- the current number of passive service checks

- the current number of active host checks
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Figure 54. Performance statistics
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Scheduling Queue displays the time of the last and next check for each monitored host or
service.

Figure 55. Scheduling Information

When you launch the Control screen from a host or a service, host or service monitoring
information and host or service comments are displayed. You can also enable/disable
notifications, enable or disable service checks.

Figure 56. Monitoring Host commands
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Host/Service Monitoring Information
Gives general information about host or service monitoring.

Host/Service Comments
Displays the comments associated to the host or service and allows you to add or delete
comments.

Host/Service Commands
Enables actions on monitoring functions.

When you click a command, you are prompted to confirm by clicking Commit in the
confirmation page. The command is posted for immediate execution by the Monitoring
Server.

Note:
Commands require Administrator rights.

Reporting Information
The following table lists the available information types and associated supervision scope.

Information Type Supervision Scope
Alert History Root nodes of Hosts and Hostgroups views (Tree)

Hostgroup,
Host,
Service.

Notifications Root nodes of Hosts and Hostgroups views (Tree),
Hostgroup,
Host,
Service.

Avaibility Root nodes of Hosts and Hostgroups views (Tree),
Hostgroup,
Host,
Service.

Status Trends Root nodes of Hosts and Hostgroups views (Tree)
Host,
Service

Indicator Trends Root nodes of Hosts and Hostgroups views (Tree)
Hostgroup,
Host,
Service.

Alert History
This screen displays host and service alerts according to the selected context. For example,
when this screen is called from a Hostgroup, only the Alerts related to the hosts contained in
the selected Hostgroup are given, as displayed below. Information about Alert History is
detailed in Looking in the Past with Alert History, on page 2-6.
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Figure 57. Alert History screen - example

Notifications
This screen displays notifications that have been sent to various contacts, according to the
selected context. When this screen is called from a Root node, it reports all notifications for
all the resources declared in the NovaScale Master application, as displayed below.

Figure 58. Notifications screen - example
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The screen is divided into two parts:

• The top part of the screen allows you to modify the notifications reported, according to a
set of criteria:

Log File By default, only the notifications recorded in the current log
are displayed.

To see older notifications, you can select an archived log.
Notification Level Allows you to select the type of Notifications displayed (Ser-

vice notifications, Host notifications Host Dow, Service Criti-
cal,…).

By default, all notifications are displayed.
Earliest Entries First Allows you to select the order of notifications displayed.

By default, the most recent notifications are displayed first.
• The bottom part of the screen contains matching notification information according to the

context and the criteria set in the top part of the screen.

Notifications and information about these notifications (Time, Type, Notified Contacts, …) are
displayed according to the criteria previously set. Type information reflects the severity of the
notification.

Avaibility
This screen reports on the availability of hosts and services over a user-specified period of
time. When called from a root node, it will report the avaibility summary for each host
declared in the NovaScale Master application. When called from a Host context, the report
will be more detailed as displayed below.

Figure 59. Availability screen - example
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The screen is divided into two parts:

- The top part allows you to choose the period over which the report is built (Report
Period selection box). The default period is the last 24 hours.

- The bottom part displays reporting information, according to the context and the
report period.

The following information is reported:

Host State Breakdowns or
Service State Breakdowns

Represents the percent of time spent by the host or service in
each of its possible states.

Note:
Time Unknown is reported when the monitoring server cannot
obtain information about the service (because, for instance, the
host is down, or the monitoring agent is not running on the tar�
get).
Time Undetermined is reported when no information was col�
lected, mainly because the monitoring server was not running.

Services State Breakdowns This information is available if the report is asked for a host.
Availability report for all the services of the host.

Host Log Entries or
Service Log Entries

List of all the Nagios events logged for the host or service dur�
ing the chosen period.

Status Trends
This screen displays a graph of host or service states over an arbitrary period of time, as
displayed below.

Figure 60. Status Trends on a Service

The screen is divided into two parts:

• The top part allows you to select the period for which the report is built (Report Period
selection box). The default period is the last 24 hours.
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• The bottom part displays information, according to the context and the selected report
period.

The following information is reported:

Chronology Represents the evolution of the host or service status over the se-
lected time period.

Availability Represents the percent of time spent in each state for the host or
service.

Indicator Trends
The Indicator Trends screen lists the available indicator reports defined for a given resource,
as displayed below.

Information about how to visualize reports associated with these indicators are detailed in
Reports, on page 4-7.

Figure 61. Indicator Trends on a Host

Inventory Information
The Inventory menu is divided into two submenus: Platform and Operating System.

Platform Information
These screens are available for Host or Service supervision. Information levels vary to OS
and host type.

Inventory Information
This information is OS-dependent and is only available for hosts with Windows or Linux
Operating Systems.

For Windows hosts, this screen displays the following information:

• Computer Information

• Processors Information

• Physical Memory Information

• Cache Memory Information
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• Non-Storage Devices Information

Figure 62. Windows Inventory information - example

For Linux hosts, this screen displays the following information:

• Hardware Information

• Memory Usage
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Figure 63. Linux Inventory information - example

Storage Information
This information is OS-dependent and is only available for hosts with Windows or Linux
Operating Systems.

Figure 64. Windows Storage information - example

FRU Information
This information is only available for Express 5800 and NovaScale 3000, 4000, 5000 and
6000 series hosts.

For details about the displayed information, refer to Chapter 4.

Sensor Information
This information is only available for Express 5800 and NovaScale 3000 and 4000 series
hosts.
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For details about the information displayed, refer to Chapter 4.

SEL Information
This information is only available for Express 5800 and NovaScale 3000, 4000, 5000 and
6000 series hosts.

For details about the information displayed, refer to Chapter 4.

Operating System Information
These screens are available for Host or Service supervision. Information levels vary
according to OS and host type.

Windows Information
The Windows System screen displays the following information:

• OS Version Information

• OS Computer Information

• OS Installation Information

Figure 65. Windows System screen - example
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The Windows Process screen displays running processes:

Figure 66. Windows Process screen - example

The Windows Users screen displays users information:

Figure 67. Windows Users screen - example

The Windows Products screen displays installed products:

Figure 68. Windows Products screen - example

Note:
On servers running Windows Operating System, only products installed using a .MSI file are
displayed.
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The Windows Logical Disks screen displays information about logical disks:

Figure 69. Windows Logical Disks screen - example

The Windows Services screen displays services information:

Figure 70. Windows Services screen - example

Linux Information
The Linux Systemscreen displays the following information:

• System Information

• Network Information

• Memory Usage Information

• Mounted Filesystems Information
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Figure 71. Linux System screen - example

The Linux Process screen displays processes sorted by PID, User, Memory Usage or CPU
Usage.

The following example shows processes sorted by Memory Usage. You can select the
required sort option by clicking the corresponding link.
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Figure 72. Linux Process screen - example

The Linux Users screen displays user information:

Figure 73. Linux Users screen - example

The Linux RPM Products screen allows you to display installed packages by using a search
tool or by browsing the package tree.
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Figure 74. Linux RMP Products search screen - example

For example, if you enter SNMP in the search field and then click Search For Package, the
following display appears:

Figure 75. Linux RPM Products - example

The Linux System Logs screen displays available logs and allows you to view them.

Figure 76. Linux System Logs screen - example

Operations Menu
The Operations menu  allows an Administrator to take a remote control of a platform or
Operating System.

This menu is only available to Administrators and is divided into several potential submenus:
Platform, Operating System, Consolidation, Applications and Storage.

Platform Menu
These menus are available for Hardware Manager and Host (and services) with a dedicated
hardware manager.

Power Control
Allows the administrator to manage power control through the NovaScale Master Hardware
Management application.

Manager GUI
Allows you to launch the appropriate hardware manager:

• PAM for NovaScale 5000 and 6000 series

• ISM for NovaScale 4000 series

• CMM for NovaScale Blade series

• ESMPRO for Intel based computers, running Windows
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• RMC or ARMC for Intel based computers.

• Any other manager that can be accessed via a URL.

Operating system Menu
These menus are available for Host or Service supervision. Information levels vary according
to OS and host type.

Remote Operation Menu for Windows

… ->VNC Viewer Starts VNC viewer to connect to this host.

… ->MMC

… ->Remote Desktop
Remote Operation Menu for Linux

… ->SSH Launches SSH to connect to this host.

… ->Shell 

     … -> FileSystem

… -> Processes

… ->  Users

… -> Password

… -> RPM 

… -> System Logs

… -> NetConfig

Following items Open a Webmin page:

to execute a Unix shell command.

to manage disk and network file systems.

to manage running processes.

to manage Users and Groups.

to manage passwords.

to manage software packages.

to manage system logs.

to manage network configuration.

Note:
SSH command calls a Console local SSH client. This command runs only on Linux console
machines.

Storage Menu
This menu is available for Storage Manager, Host or Service supervision.

From this menu you can call the storage manager GUI.

Consolidation Menu
This menu is available for Host supervision.

From this menu you can call specific management tools for virtualization and/or
consolidation (generally these items come with specific Server Add-ons).

Application Menu
This menu is available for Host supervision.

From this menu you can call specific management tools for specific Bull applicative
framework and/or applications (generally these items come with specific Server Add-ons).
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Chapter 4. Using NovaScale Master Console Applications

NovaScale Master Hardware Management Application
The NovaScale Master Remote Hardware Management Application provides the same look
and feel for hardware operations independently of the target machine type.

This application manages Power Control, and displays FRUs, Sensors and System Event Logs
for Express 5800 and NovaScale 4000, 5000 or 6000 series servers.

There are two ways to start the application:

• Launch the Hardware Management Application from the application bar

• Activate the Hardware -> Remote Control item in the Console Management Tree host
menu.

 Host selectionAction pane Display pane

Figure 77. Remote Hardware Management screen

NovaScale Master Remote Hardware Management comprises three functional parts:

Host Selection Pane & Current Selected Host Pane 
Allows you to select the current host from all the Express 5800 and
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NovaScale 4000, 5000 or 6000 servers declared in the NovaScale Master
configuration and displays it.

Action Pane Displays the hardware operations that can be executed.

Display Pane Displays parameter forms, messages and command results.

Host Selection
Hardware commands only apply to the selected host. The selected host name is displayed in
the Current Selected Host Pane.

The application is launched contextually from the Current Selected Host in the Console
Management Tree.

You can select another host from the list of available hosts in the Host Selection Pane.

When a host is selected, the application reads NovaScale Master configuration files to get
host properties.

Host Properties
You can display selected host properties by clicking View:

Figure 78. NovaScale 5000 Server host properties - example

Host properties differ according to host type, as shown in the following tables:

Name Name of the current selected host to which commands are applied.

Model Host model.

Network Name Current selected host local network name or IP address.

Operating System Operating system type (Windows, Linux or any).

User SMU authentication user. This user must be configured using ISM
(Intel System Management) and is specific to the managed host.
Therefore, this field is different from the User field required as Au�
thentication for Monitoring when declaring an ISM Manager in No�
vaScale Master Configuration.

Password SMU authentication password.

Table 16. NovaScale 4000 Server host properties
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Name Name of the current selected host to which commands are applied.

Model Host model.

Domain Current selected host domain name.

Operating System Operating system type (Windows, Linux or any)

Platform Platform name.

Manager Name PAM Manager name.

Manager Network
Name

Local network name or IP address of the PAP server managing the cur�
rent selected host.

User PAM authentication user (valid PAP server user).

Password PAM authentication password.

Table 17. NovaScale 5000 or 6000 Server host properties

Name Name of the current selected host to which commands are applied..

ModelHost model.

Network Name Current selected host local network name or IP address.

Operating System Operating system type (Windows, Linux or any).

RMC Netname RMC network name.

RMC password RMC password.

Table 18. Express 5800 Server host properties

Note:
These values always correspond with those found in the NovaScale Master Configuration.

Commands

Note:
All commands are applicable to the Current Selected Host.

Prerequisites

NovaScale 3000 Servers
The BMC (Baseboard Management Controller) on the managed host must be configured for
remote-control over LAN.

NovaScale 4000 Servers
An SMU (System Maintenance Utility) user must be declared for the managed host via the
ISM (Intel Server Management) software delivered with NovaScale 4000 servers. Uuser
authentication must be declared in the NovaScale Master Configuration.

NovaScale 5000 and 6000 Servers
NovaScale Master Hardware commands are sent to the PAP server for execution. The only
prerequisite is that the targeted host is managed by an operational PAP unit accessible from
the NovaScale Master server.

Express5800 Servers
The BMC (Baseboard Management Controller) on the managed host must be configured for
remote-control over LAN. This is done using the MWA (Management Workstation
Application) or DOS configuration tool available on the NEC EXPRESSBUILDER CD-ROM
delivered with EXPRESS5800 Series servers.
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Command Outputs
A message indicating command failure or acceptance is displayed.

Power Control
As Power Control operations (except Power Status) are executed asynchronously, the output
only indicates if the command is accepted and started. It does not indicate whether the
command has been executed or not.

Figure 79. Power Status output - example

Note:
In order for the "power off" command to be taken into account on a remote host running
Windows 2000 / 2003 server, the "Shutdown: Allow system to be shut down without having
to log on" security option must be enabled on the remote host.

You can configure this security setting by opening the appropriate policy and expanding the
console tree as such:

1. Click Start, and then click Run.

2. In the Open box, type gpedit.msc, and then click OK.

3. In the Group Policy window, expand Computer Configuration\Windows Settings\Security
Settings\Local Policies\Security Options\.

4. Set the shutdown security option to "enabled".
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FRU
Click FRU to display the FRUs (Field Replacement Unit).

Figure 80. FRU output - example

SENSOR
Click Sensor to display sensors.

Note:
This option is not available for NovaScale 5000 and 6000 series servers.

Figure 81. SENSOR output - example
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SEL/PAM History
Click SEL (Express 5800 and Nova Scale 4000 Series) or PAM History (Nova Scale 5000
and 6000 Series) to display the 20 most recent records of the System Event Log.

You can view records according to rank, to naviagate to next or previous records and to
view the oldest records.

Note:
The Refresh button is only enabled when the most recent records are displayed.

 

Figure 82. SEL output - example

 

Figure 83. PAM History output - example
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Reports
You can visualize the reports associated with these indicators, as follows:

1. Launch the NovaScale Master Console and click Reports button to display available
reports.

2. Click the required report.

 

Figure 84. Indicator Reports

Each report comprises four graphs:

• Daily

• Weekly

• Monthly

• Yearly
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Figure 85. Daily and Weekly Report Graphs - example
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Other Applications
You can launch external applications by clicking the required icon in the Other Tools Pane. 
Use the arrows to scroll through the list of applications. As Administrator, you can add
external applications. Please refer to the Administrator's Guide for details.

Note:
The Bull icon gives you direct access to the Bull Web Site.

Figure 86. Other applications
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Chapter 5. Categories and Services Reference List

This chapter describes the categories and default services for monitoring Linux or Windows
systems.

As Administrator, you can change, remove or add categories and services to the
configuration. Please refer to the Administrator's Guide for details.

 Notes:

• Other Categories and Services are provided by NovaScale Server Add-Ons. They are
described in the NovaScale Master Server Add-ons Installation and Administrator's Guide.

• A PING monitoring service allows you to monitor the presence of a targeted Host. This
service is not represented by a service node in the Management tree but is represented in
the Applications Pane (Monitoring Status Details).

Monitoring Hosts
The following categories and services can be used to monitor items independent from OS
(network access and protocols for instance). By default they appear under any declared host.

Internet Category
This category contains all the services for monitoring IP port (TCP, UDP, HTTP, FTP, ...).

HTTP
The Internet.HTTP service monitors the HTTP access of the hosts on port 80 (by default) on the
'/' URL (i.e. http://host:80/). The timeout value is 10 seconds.

• Status is set to WARNING state for HTTP errors: 400, 401, 402, 403 or 404 such as
'unauthorized access'.

• Status is set to CRITICAL state if the response time exceeds 10 seconds or for HTTP errors
500, 501, 502 or 503, or if the connection with the server is impossible.

HTTP_NSMaster
The Internet.HTTP_NSMaster service monitors the presence and status of the NS Master URL.

FTP
The Internet.FTP service checks the accessibility of FTP on its standard port (21).

• Status is set to WARNING state if the connection is successful, but incorrect response
messages are issued from the host.

• Status is set to CRITICAL state if the response time exceeds 10 seconds or if the connection
with the server is impossible.

TCP_n
The Internet.TCP_n service monitors a TCP port access of the hosts.

• Status is set to CRITICAL state if the connection with the server is impossible.

UDP_n
The Internet.UDP_n service monitors a UDP port access of the hosts.

• Status is set to CRITICAL state if the connection with the server is impossible.
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Reporting Category
This category contains all the services for monitoring reporting indicators associated to a
threshold.

Perf_indic 
The reporting.Perf_indic service monitors defined reporting indicators.

Please refer to the Administrator's Guide for details.
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Monitoring Linux Systems
The following categories and services can be used to monitor Linux systems. By default they
appear under any host, declared as a Linux system.

FileSystems Category
This category contains all the services for monitoring file systems.

All Service
The FileSystems.All service monitors the percentage of used space for each mounted
filesystem, except CD-ROM and floppy disks.

• Status is set to WARNING if there is at least one filesystem with more than 80% used
space.

• Status is set to CRITICAL if there is at least one filesystem with more than 90% used space.

Status Information
If status is set to WARNING or CRITICAL, Status Information lists the filesystems concerned.

Examples:

DISKS OK: all disks less than 80% utilized

DISKS WARNING: /home more than 80% utilized

DISK CRITICAL: ( / ) more than 90% utilized – DISKS WARNING: ( /usr /var )
more than 80% utilized

Correcting Status
• From the Applications Pane, click System (Detailed Information box)  to get information

about host filesystem size.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> Actions -> FileSystems. 
You now have access to the host and you can investigate and correct the problem.

LinuxServices Category
This category contains all the services for checking the presence of a Linux daemon.

Syslogd Service
The Syslogd service checks that there is one and only one syslogd process running on the
system.

Note:
Syslogd is a system utility daemon that provides support for system logging.

• Status is set to WARNING if the number of syslogd processes is different from 1.

• Status is only set to CRITICAL when a processing error occurs.

Status Information
Gives the number of processes running with the syslogd name.

Examples:

OK - 1 processes running with command name syslogd

Correcting Status
• From the Applications Pane, click Processes (Detailed Information box)  to get the list of

processes currently running on the system.
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• From the Tree Pane, display the host pop-up menu and select: 
Remote Operation -> Actions -> Processes or Remote Operation -> Telnet.
You now have access to the host and you can investigate and correct the problem.

Syslog Category
This category contains all the services for monitoring the content of the syslog files.

AuthentFailures Service
The AuthentFailures service monitors the /var/log/messages file for the detection of
authentication failure messages. It searches for the lines containing: 
authentication failure or FAILED LOGIN or Permission denied, 
but not containing login.*authentication failure (because such a line traps the same error
than a FAILED LOGIN line, already detected).

Note:
Only new lines (if any) are checked each time. If the file has been truncated or rotated since
the last check, the search is started from the beginning.

• Status is set to WARNING if there is at least one new matching line since the last check.

• Status is only set to CRITICAL when a processing error occurs.

Important:
WARNING status can be very fugitive in the Console.
When a new matching line appears in the log file, status is only set to WARNING during the
interval between the check that detects the error and the next check (if no new error
appears). You are therefore advised to activate the notification mechanism for this service,
and to regularly consult service history.

Note:
The notify_recovery field is set to because it is not applicable to this service.

Status Information
If status is set to WARNING, Status Information gives the number of lines and the last line
matching the searched patterns.

Examples:

OK - No matches found

(3): Nov 26 15:31:32 horus login[4786]: FAILED LOGIN 3 FROM isis FOR admin,
Authentication failure

Note:
(3): indicates that 3 matching lines were found; the text that follows (Nov 26 15:31:32
horus…) is the last matching line detected.

Correcting Status
• From the Applications Pane, click System Logs (Detailed Information box)  to access the

content of the syslog files for the system. Then click View for /var/log/messages to consult
log file details.

• From the Tree Pane, display the host pop-up menu and select: 
Remote Operation -> Actions or Telnet.
You have now access to the host and you can investigate and correct the problem.
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SystemLoad Category
This category contains all the services for monitoring system load.

CPU Service
The CPU service monitors total CPU load over three periods of time:

• 1 min

• 5 min

• 15 min

CPU load is computed using the load average given by the w command, or in the 
/proc/loadavg file. Load average is the average number of processes in the system run
queue, that is, the number of processes able to run:
(load average / number of CPUs) * 100.

Therefore, CPU load should be equal to 100% when the average of running processes per
CPU is 1 (all CPUs are busy).

• Status is set to WARNING if the average CPU load is higher than:

- 80% over the last 1 minute

- 70% over  the last 5 minutes

- 60% over the last 15 minutes.

• Status is set to CRITICAL if the average CPU load is higher than:

- 90% over the last 1 minute

- 80% over the last 5 minutes

- 70% over the last 15 minutes.

Status Information
Displays the percentage of average CPU load for respectively the last 1 minute, the last 5
minutes and the last 15 minutes.

Examples:

CPU Utilization: 0% (1mn), 1% (5mn), 0% (15mn)

CPU Utilization: 86% (1mn), 51% (5mn), 33% (15mn) WARNING

Correcting Status
• From the Applications Pane, click Processes (Detailed Information box)  to get process

CPU consumption.

• From the Tree Pane, display the host pop-up menu and select: 
Remote Operation -> Actions -> Processes
You have now access to the host and you can investigate and correct the problem.

Memory Service
The Memory service monitors the percentage of used memory (physical + swap) for the
system.

• Status is set to WARNING if used memory is higher than 70%.

• Status is set to CRITICAL if used memory is higher than 90%.

Status Information
Displays the total (physical + swap) memory size in Mbytes, the total used memory in Mbytes
and percent, the total free memory in Mbytes and the physical memory size in Mbytes.
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Examples:

Status: OK - (total: 2996Mb) (used: 863Mb, 29%) (free: 2132Mb) (physical: 1004Mb)

Status: WARNING - (total: 1097Mb) (used: 878Mb, 80%) (free: 219Mb) (physical: 501Mb)

Correcting Status
• From the Applications Pane, click System (Detailed Information box)  to get memory

consumption details.
Click Processes to get information on memory consumption for each process running on
the system.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> Actions, or Remote Operations -> Telnet

You have now access to the host and you can investigate and correct the problem.

Processes Service
The Processes service monitors the number of processes running on the system.

• Status is set to WARNING if the number of processes is higher than 150.

• Status is set to CRITICAL if the number of processes is higher than 200.

Status Information
Displays the number of processes running on the system.

Examples:

OK - 101 processes running

WARNING - 162 processes running

Correcting Status
• From the Applications Pane, click Processes (Detailed Information box)  to get the list of

the processes.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> Actions -> Processes.
You have now access to the host and you can investigate and correct the problem.

Users Service
The Users service monitors the number of users currently logged in the system.

• Status is set to WARNING if the number of connected users is higher than 15.

• Status is set to CRITICAL if the number of connected users is higher than 20.

Status Information
Displays the number of users logged to the system.

Examples:

USERS OK - 2 users currently logged in

USERS WARNING - 16 users currently logged in

Correcting Status
• From the Applications Pane, click Processes (Detailed Information box)  to get information

on users running processes.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> Actions or Remote Operation -> Telnet 
You have now access to the host and you can investigate and correct the problem.
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Monitoring Windows Systems
The following categories and services can be used to monitor Windows systems. By default
they appear under any host, declared as a Windows system.

Note:
The Windows monitoring agent part is based on two Windows services:

NovaScale Master Management agent

Its main function is giving OS and HW information, but it provides the "LogicalDisk.All"
monitoring service too.

NovaScale Master Monitoring agent

It provides all Windows monitored services, except "LogicalDisk.All".

EventLog Category
This category contains all the services for monitoring the Windows Event Log.

Application Service
The EventLog.Application service monitors the number of Error, Warning and Information
events generated in the Application Event log for the last 300  minutes.

• Status is set to WARNING if there are more than 10 Information events or at least 1
Warning event.

• Status is set to CRITICAL if there is at least 1 Error event.

Status Information
If status is set to WARNING or CRITICAL, gives the number of events responsible. This
message is also a link to an html file containing the following detailed information:

Event Type Error or Warning or Information.

Last Time Last time an event with the same type, source and id occured.

Count Number of events with the same type, source and id.

Source Event source.

Id Event id.

Description Event message.

Examples:

OK: no new events for the last 30 mn

WARNING: 1 new events for the last 30 mn!

The text "1 new events for the last 30 mn!" is a link that displays detailed information:

Correcting Status
• From the Applications Pane, click Events (Detailed Information box) for more information.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> VNC Viewer or Remote Operation -> Telnet. 
You have now access to the host and you can correct the problem.
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Security Service
The EventLog.Security service monitors the number of Audit Success, Audit Failures, Error and
Warning events generated in the Security event log over the last 30 minutes.

• Status is set to WARNING if there are more than 10 Audit Success events or at least 1
Warning event.

• Status is set to CRITICAL if there is at least 1 Audit Failure or Error event.

Status Information
If status is set to WARNING or CRITICAL, gives the total number of events responsible. This
message is also a link to an html file containing the following detailed information:

Event Type Error, Warning, Information, Audit Success or Audit Failure.

Last Time Last time an event with the same type, source and id occurred.

Count Number of events with the same type, source and id.

Source Event source.

Id Event id.

Description Event message.

Examples:

OK: no new events for the last 30 mn

WARNING: 4 new events for the last 30 mn!

Correcting Status
• From the Applications Pane, click Events (Detailed Information box) for more information.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> VNC Viewer or Remote Operation -> Telnet. 
You have now access to the host and you can correct the problem.

System Service
The EventLog.System service monitors the number of Error, Warning and Information events
generated in the System event log over the last 300  minutes.

• Status is set to WARNING if there are more than 10 Information events or at least 1
Warning event.

• Status is set to CRITICAL if there is at least 1 Error event.

Status Information
If status is set to WARNING or CRITICAL, gives the total number of events responsible. This
message is also a link to an html file containing the following detailed information:

Event Type Error, Warning or Information.

Last Time Last time an event with the same type, source and id occurs.

Count Number of events with the same type, source and id.

Source Event source.

Id Event id.

Description Event message.

Examples:

OK: no new events for the last 30 mn

CRITICAL: 8 new events for the last 30 mn!
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Correcting Status
• From the Applications Pane, click Events (Detailed Information box) for more information.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> VNC Viewer or Remote Operation -> Telnet. 
You have now access to the host and you can investigate and correct the problem.

LogicalDisks Category
This category contains all the services for monitoring the logical disks.

All Service
The All service monitors the percent of used space for each local disk. The local disks list is
dynamically established at each check.

• Status is set to WARNING if one of the disks has more than 80% used space.

• Status is set to CRITICAL if one of the disks has more than 90% used space.

Status Information
Gives the list of the local disks checked.

Examples:

DISKS OK: all disks (C:, E:, F:) less than 80% utilized

DISK WARNING: (G:) more than 90% utilized - DISKS CRITICAL: (C:) more than 80%
utilized

Correcting Status
• From the Applications Pane, click Logical Disks (Detailed Information box) to get all

information about the size of the host disks. Then click Storage to get information on the
physical storage devices for the host.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> VNC Viewer or Remote Operation -> Telnet. 
You have now access to the host and you can investigate and correct the problem.

SystemLoad Category
This category contains all the services for monitoring the load of the system.

CPU Service
The CPU service monitors the total CPU load over two periods of time: 1min and 10 min

• Status is set to WARNING if the average CPU load is higher than:

- 80% over the last 1 minute

- 60% over the last 10 minutes.

• Status is set to CRITICAL if the average CPU load is higher than:

- 90% over the last 1 minute

- 80% over the last 10 minutes.

Status Information
Displays the percentage of average CPU load for respectively the last 1 minute and the last 
10 minutes. If status is WARNING or CRITICAL, it displays the most consuming process, and
its percentage of CPU consumption, at check time.
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Examples:

CPU Load OK (1mn: 8%) (10mn: 5%)

CPU Load HIGH (1mn: 92%) (10mn: 56%) - Process cputest.exe using 100%

Correcting Status
• From the Applications Pane, click CPU (Detailed Information box) to get CPU consumption

per processor. Then click Processes to get CPU time spent per process.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> VNC Viewer or Remote Operation -> Telnet. 
You have now access to the host and you can investigate and correct the problem.

MemoryUsage Service
The MemoryUsage service monitors the total memory (physical + paged) used by the system.
It is equivalent to the Commit Charge displayed in the Windows Task Manager.

• Status is set to WARNING if the memory used is higher than 70%.

• Status is set to CRITICAL if the memory used is higher than 90%.

Status Information
Displays the total (physical + paged) memory size in Mbytes, the total memory used in
Mbytes and percent, the total memory free in Mbytes and the physical memory size in
Mbytes.

Examples:

Memory Usage OK - (total: 1480Mb) (used: 193Mb, 13%) (free: 1287Mb) (physical:
511Mb)

Memory Usage WARNING - (total: 2462Mb) (used: 1773Mb, 72%) (free: 689Mb)
(physical: 1023Mb)

Correcting Status
• From the Applications Pane, click Memory (Detailed Information box) to get detailed

memory consumption.
Then click Processes to get memory consumption spent per process.
Then click General (Host Information box) to get information about the physical memory
configuration and layout.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> VNC Viewer or Remote Operation -> Telnet. 
You have now access to the host and you can investigate and correct the problem.

WindowsServices Category

EventLog Service
The WindowsServices.EventLog service monitors the state of the services involved in event
logging functions:

Service
Key

Display
Name

Description

Eventlog Event Log Log event messages issued by programs and Windows.
Event Log Reports contain information that can be useful
in diagnosing problems. Reports are viewed in Event
Viewer

• Status is set to WARNING at least one of these services is paused and the others are
running.

• Status is set to CRITICAL if at least one of these services does not exist or is not running.



5-11Categories and Services Reference List

Status Information
Displays service name and status.

Examples:

OK: `EventLog'

NotActive: `EventLog'

Correcting Status
• From the Applications Pane, click Memory (Detailed Information box) to get detailed

information about services.

• From the Tree Pane, display the host pop-up menu and select:
Remote Operation -> VNC Viewer or Remote Operation -> Telnet. 
You have now access to the host and you can investigate and correct the problem.



5-12 User's Guide

Hardware Monitoring

Hardware Category for Express 5800

PowerStatus Service
The PowerStatus service reflects the power status of an Express5800 server, as returned by
the RMC management card.

• Status is set to CRITICAL if RMC has assigned a power status off.

• Status is set to UNKNOWN if RMC is not accessible or if RMC has not been able to
compute power status.

Correcting Status
• From the Tree Pane, display the host pop-up menu and select RMC to launch the CMM tool

and investigate and correct the problem.

Note:
For more information about RMC, please refer to the documentation delivered with your
server.

Alerts Service
The Alerts Service is used to collect the hardware SNMP traps emitted by the manager.

This service uses the mib bmclanpet, integrated in the NovaScale Master application. and
SNMP trap reception must be enabled.

The Hardware Management card must be correctly configured to send traps to the
NovaScale Master_SERVER host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.

• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details.

Hardware Category for NovaScale 3000 Series

PowerStatus Service
The PowerStatus service reflects the power status of a NovaScale server, as returned by the
management card.

• Status is set to CRITICAL if the cardName has assigned a power status off.

• Status is set to UNKNOWN if  the cardName is not accessible or if the cardName has not
been able to compute power status.

Alerts Service
The Alerts Service is used to collect the hardware SNMP traps emitted by the manager.

This service uses the mibs bmclanpet and SMSmp integrated in the NovaScale Master
application. SNMP trap reception must be enabled.

The Hardware Management BMC must be correctly configured to send traps to the
NovaScale Master_SERVER host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.
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• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details.

Hardware Category for NovaScale T800 & R400 Series

PowerStatus Service
The PowerStatus service reflects the power status of a NovaScale server, as returned by the
management card.

• Status is set to CRITICAL if the cardName has assigned a power status off.

• Status is set to UNKNOWN if  the cardName is not accessible or if the cardName has not
been able to compute power status.

Alerts Service
The Alerts Service is used to collect the hardware SNMP traps emitted by the manager.

To enable this service, the mib bmclanpet must be integrated in the NovaScale Master
application. SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The Hardware Management cardBMC must be correctly configured to send traps to the
NovaScale Master_SERVER host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.

• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details.

Hardware Category for NovaScale Blade Series

Health Service
The Health service monitors hardware status, as returned by the CMM software tool.

To enable this service, a CMM manager must be declared for the host and the hardware
identifier (used to identify the host in the NovaScale Blade Chassis) must be provided during
NovaScale Master configuration. Please refer to the Administrator's Guide for details.

• Status is set to WARNING if CMM has assigned a WARNING status to the host.

• Status is set to CRITICAL if CMM has assigned a CRITICAL status to the host.

• Status is set to UNKNOWN if CMM is not accessible or if the host has not been
successfully mapped in the chassis (due for example to an incorrect hardware identifier).

Status Information
Status information is set by CMM and represents the host hardware status.

Examples:

Current status: OK

Status Information No critical or warning events

⇒  The hardware state of the host is OK.
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Current status: CRITICAL

Status information: DASD Removed.

⇒  The hardware state of the host is CRITICAL.

Current status: unknown

Status information: Unable to get SNMP response [No response from remote host
'192.168.207.46'

⇒  The hardware state can't be retrieved from the CMM manager due to connection timeout.
This issue can result from a bad declaration of the SNMP Manager in the CMM
configuration.

Correcting Status
• From the Tree Pane, display the host pop-up menu and select HW Manager GUI to launch

the CMM tool and investigate and correct the problem.

Note:
For more information about CMM, please refer to the documentation delivered your server.

Hardware Category for NovaScale 4000 Series

Alerts Service
The Alerts Service is used to collect the hardware SNMP traps emitted by the host.

To enable this service, the mib basebrd5 must be integrated in the NovaScale Master
application and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

Traps are previously filtered and only the traps emitted by the Hardware Management card
are used to animate this service. The Hardware Management card must be properly
configured with the Intel SMU tool to send traps to the NovaScale Master_server host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.

• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details.

Status Information
Trap description, as found in the trap mib, is used as status information

Example:

Trap systemHealthCriticalEvent � Server Health Critical: The overall health of the server is
critical

Correcting Status
• From the Tree Pane, display the host pop-up menu and select HW Manager GUI to launch

the ISM tool and investigate and correct the problem.

Note:
For more information about ISM, please refer to the documentation delivered your server.
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Health Service
The Health service monitors hardware status, as returned by the Intel System Management
(ISM) software tool.

To enable this service, a manager must be declared for the host (see the Administrator's
Guide for details about how, as Administrator, you can declare a manager) and ISM must be
installed and running on that manager.

Health is an ISM indicator that reflects the global state of hardware. The hardware
components taken into account in Health can be configured in ISM.

• Status is set to WARNING if the status of one of the hardware components described as a
contributor to Health is WARNING.

• Status is set to CRITICAL if the status of one of the hardware components described as a
contributor to Health is CRITICAL.

Correcting Status
• From the Tree Pane, display the host pop-up menu and select:

HW Manager GUI to launch the ISM tool and investigate and correct the problem.

Hardware Category for NovaScale 5000 & 6000 Series

Health Service
The Health service monitors hardware status, as returned by the PAM software tool, for the
host (or PAM domain).

To enable this service, a manager must be declared for the host (see the Administrator's
Guide for details about how, as Administrator, you can declare a manager) and a PAP
server must be installed and running on that manager.

• Status is set to WARNING if PAM has assigned a WARNING status to the domain.

• Status is set to CRITICAL if PAM has assigned a CRITICAL status to the domain.

• Status is set to UNKNOWN if PAM is not accessible or if PAM has not successfully
computed domain status.

Status Information
Status information is set by PAM and represents host hardware status.

Examples:

For the Domain FAME000_0ID0 of the CentralSubSystem FAME000, the functional status is
NORMAL (The domain state is "BIOS READY - STARTING EFI)

Correcting Status
• From the Tree Pane, display the host pop-up menu and select:

PAM to launch the PAM tool and investigate and correct the problem.

Note:
For more information about PAM, please refer to the documentation delivered with your
server.
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Other Monitoring

PAM Category

GlobalStatus Service
The GlobalStatus service reflects global functional status, as returned by the PAM manager.
This comprises the hardware status of the whole configuration managed by this instance of
PAM, as well as the status of the PAM manager itself.

This service only exists on a host declared as a NovaScale 5000 / 6000 manager (see the
Administrator's Guide for details about how, as Administrator, you can declare a manager).

• Status is set to WARNING if PAM has assigned a WARNING status to the configuration.

• Status is set to CRITICAL if PAM has assigned a CRITICAL status to the configuration.

• Status is set to UNKNOWN if PAM is not accessible or if PAM has not successfully
computed global status.

Status Information
Status information is set by PAM and represents the global functional state for the managed
hosts and for the PAM manager tool.

Examples:

The PAM manager global status is WARNING

Correcting Status
• From the Tree Pane, display the host pop-up menu and select PAM to launch the PAM tool

and investigate and correct the problem.

Note:
For more information about PAM, please refer to the documentation delivered with your
server.

Alerts Service
The Alerts Service is used to collect hardware SNMP traps emitted by the manager.

To enable this service, the mib PAMEventtrap must be integrated in the NovaScale Master
application and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The Hardware Management card must have been correctly configured to send traps to the
NovaScale Master_SERVER host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.

• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details.

CMM Category

ChassisStatus Service
The ChassisStatus service reflects the functional status of the NovaScale Blade Chassis, as
returned by the CMM manager. This state comprises the hardware status of the whole
configuration managed by this CMM, as well as the status of the CMM manager itself.
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This service exists only on a host that is declared as a CMM manager (see the
Administrator's Guide for details about how, as Administrator, you can declare a manager).

• Status is set to WARNING if CMM has assigned a WARNING status to the host.

• Status is set to CRITICAL if CMM has assigned a CRITICAL status to the host.

• Status is set to UNKNOWN if CMM is not accessible or if CMM has not been able to
compute global status.

Correcting Status
• From the Tree Pane, display the host pop-up menu and select: CMM to launch the CMM

tool and investigate and correct the problem.

Note:
For more information about CMM, please refer to the documentation delivered with your
server.

Alerts Service
The Alerts Service is used to collect the hardware SNMP traps emitted by the manager. To
enable this service, the mib mmalert must be integrated in the NovaScale Master application
and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The Hardware Management card must be correctly configured to send traps to the
NovaScale Master_SERVER host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.

• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details.

RMC Category

PowerStatus Service
The PowerStatus service reflects the power status of an Express5800, as returned by the
RMC management card.

This service exists only on a host that is declared as a RMC manager (see the Administrator's
Guide for details about how, as Administrator, you can declare a manager).

• Status is set to CRITICAL if RMC has assigned a power status off.

• Status is set to UNKNOWN if RMC is not accessible or if RMC has not been able to
compute power status.

Correcting Status
• From the Tree Pane, display the host pop-up menu and select RMC to launch the CMM tool

and investigate and correct the problem.

Note:
For more information about RMC, please refer to the documentation delivered your server.

Alerts Service
The Alerts Service is used to collect the hardware SNMP traps emitted by the manager.

To enable this service, the mib bmclanpet must be integrated in the NovaScale Master
application and SNMP trap reception must be enabled.
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At installation time, the mib is integrated and SNMP trap reception is enabled.

The Hardware Management card must be correctly configured to send traps to the
NovaScale Master_SERVER host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.

• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details.
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Storage Monitoring

Storage Category

SanitStatus Service
The SanitStatus service monitors the state of the storage, returned by the S@N.IT! application,
for any host managed in the SAN.

• To enable this service, a SANIT manager must be declared for the host.

• Status is set to OK if S@N.IT! has assigned a NORMAL status to the host.

• Status is set to CRITICAL if S@N.IT! has assigned a FAULTY status to the host.

• Status is set to UNKNOWN if S@N.IT! has assigned an UNKNOWN or NOT MONITORED
status to the host OR if the storage identifier provided during the NovaScale Master
configuration is not valid. Please refer to the Administrator's Guide for details.

Correcting Status
• From the Tree Pane, display the host pop-up menu and select:

S@N.IT! to launch the client part of the application (Web or local mode) and investigate
and correct the problem.

SANIT Category

Alerts Service
The Alerts Service is used to collect the SNMP traps emitted by the S@N.IT! application.

To enable this service, the mib fcmgmt3 must be integrated in the NovaScale Master
application and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The S@N.IT! application must be correctly configured to send traps to the NovaScale
Master_SERVER host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.

• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details..

MegaRAID Category

Status Service
The Status service monitors the state of the storage, returned by the MegaRAID SNMP agent.

• To enable this service, MegaRAID category and Status service must be configured for the
host.

• Status is set to OK if agent has assigned a NORMAL status to the host.

• Status is set to CRITICAL if agent has assigned a FAULTY status to the host.

• Status is set to UNKNOWN if agent has assigned an UNKNOWN or NOT MONITORED
status to the host. Please refer to the Administrator's Guide for details.
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Alerts Service
The Alerts Service is used to collect the SNMP traps emitted by the MegaRAID SNMP agent.

To enable this service, the mib megaraid must be integrated in the NovaScale Master
application and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The MegaRAID SNMP agent must be correctly configured to send traps to the NovaScale
Master_SERVER host.

The status of this service depends on trap severity:

• Status is set to OK if trap severity is NORMAL.

• Status is set to WARNING if trap severity is INFORMATION or WARNING.

• Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator's Guide for details.
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